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COPYRIGHT, LICENSE, and WARNING PAGE 

Copyright  2002-2014 by KoamTac, Inc. All rights reserved. 
 

No part of this publication may be reproduced or used in any form, or by any electrical 

or mechanical means, without permission in writing from KoamTac, Inc. The material in 

this manual is subject to change without notices. KoamTac reserves the right to make 

changes to any product to improve reliability, function, or design. KoamTac doesn’t 

assume any product liability arising out of, or in connection with, the application or use 

of any product, circuit, or application described herein. Follow all warnings and 

instructions marked on manual and units. Use only the power source specified in this 

manual or marked on the units. 

May be covered under one or more pending and/or US Patents: US Pat. Nos. 7,769,917; 
7,954,710; 8,126,399; 8,295,368; 8,347,366; 8,346,979; 8,371,506; 8,483,614; UK Pending 
Patent App. No. 1203882.4; UK Patent Pending GB2492615.  
 
May be covered under the patent laws of the US and other countries. For patent 
information in the US, see http://www.koamtac.com/corpVis.html. There is a patent 
pending in UK as GB2492615. 
 
KDC® is a registered trademark and property of KoamTac, Inc. 
KoamTac® is a registered trademark and property of KoamTac, Inc. 
KTSync® is a registered trademark and property of KoamTac, Inc. 

  

TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THIS UNIT TO ANY TYPE OF MOISTURE. 

DO NOT LOOK DIRECTLY INTO LASER OR POINT THE LASER INTO ANOTHER PERSON’S EYES. 

EXPOSURE TO THE BEAM MAY CAUSE EYE DAMAGE. 

 

CAUTION: 

Changes or modifications not expressly approved by the manufacturer responsible for 

compliance could void the user’s authority to operate the equipment. 
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Regulatory Compliance 
 

 

FCC ID: VH9KDC30 

This equipment has been tested and found to comply with the limit of a Class B digital device, 

pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection 

against harmful interference in a residential installation. This equipment generates uses and can 

radiate radio frequency energy and, if not installed and used in accordance with the instructions, 

may cause harmful interference to radio communications. However, there is no guarantee that 

interference will not occur in a particular installation; if this equipment does cause harmful 

interference to radio or television reception, which can be determined by turning the 

equipment off and on, the user, is encouraged to try to correct the interference by one or more 

of the following measures: 

1. Reorient / Relocate the receiving antenna. 

2. Increase the separation between the equipment and receiver. 

3. Connect the equipment into an outlet on a circuit difference from that to which 

the receiver is connected. 

4. Consult the dealer or an experienced radio/TV technician for help. 

 

WARNING: 

This device complies with part 15 of the FCC Rules. Operation is subject to the following two 

conditions: (1) This device may not cause harmful interference, and (2) this device must accept 

any interference received, including interference that may cause undesired operation. 

 

 

       
 

Products intended for sale within the European Union are marked with a CE Mark which 

indicates compliance to applicable Directives and European Normes (EN), as follows. 

Amendments to these Directives or ENs are included: Normes (EN), as follows: 

 

Applicable Directives:  
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toxic substances.     
- Dispose of used battery in accordance with the prevailing community regulations 

that apply to the disposal of batteries.  Cover the metal terminals with insulating 
tape.  (This is to prevent accidental short-circuiting).  
- Never expose the battery to any liquid. 
- Always keep the battery out of reach of infants or small children. 
- Never shock the battery by dropping it or throwing it. 
- Dispose of a spent or damaged battery promptly.  
 
WARNING: RISK OF EXPLOSION IF BATTERY IS REPLACED BY AN INCORRECT TYPE. 
DISPOSE OF USED BATTERIES ACCORDING TO THE INSTRUCTIONS. 
 
 
Product Disposal 
Your device should not be placed in municipal waste. Please check local regulations  
for disposal of electronic products. 

 

Bluetooth 
Core Specification: 2.1+EDR 
 
 
Apple 
Made for iPhone, Made for iPod, Made for iPad 
 
 
Samsung 
Compatible with Galaxy Series 
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1. Introduction 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Congratulations on purchasing KoamTac’s revolutionary barcode scanner and data 

collector.  Lightweight and compact, with a user-friendly design and superior 

functionality, KoamTac’s KDC works in a variety of portable applications.  Use it 

independently or as an accessory to your PC, PDA, or smartphone.  To find out more 

about KoamTac, Inc. and our family of products, visit us at www.koamtac.com. 

 

 

 

KDC30 Specifications 

FEATURE 

 

Barcode scanner 

Compliant with Class II Bluetooth v2.0 and v2.1Enhanced 

Data Rate(EDR) support 

MAJOR PARTS  AT91SAM7S256-AU (ARM7 32bits Processor) 

S3C6410X-533 (ARM11 RISC Microprocessor) 

MT29F1G08ABBEAH4 (1Gbit NAND Flash Memory) 

K4X51323PK-8GD8 (512Mbit Mobile DDR SDRAM) 

F1E22 (Bluetooth module) 

CR8000 (Decoded Scan Engine (CAM)) 

BLUETOOTH STANDARDS  Class II Bluetooth v2.1 + EDR 

2.4 GHz - 2.4835 GHz 

SPP, HID profile 

Internal chip Antenna 

INTERFACE  USB 2.0/1.1 (A-type connector) 

POWER Lithium-Polymer Battery (Typ. 3.7V, 650mAh) 

Typ. 300mA Consumption @ 3.3V 

PHYSICAL DIMENSIONS 1.50”x3.29”x0.71” (38mmX83.5mmX18mm) 

WEIGHT  1.82oz. (51.5grams) 

Table 1 – KDC30 Specifications 
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 KDC Package 1.1 

 

The standard KDC package contains: 

1. One KDC Barcode Data Collector 

2. One USB Cable 

3. One Lanyard  

4. KoamTac Installation CD with 

� KTSync© for Microsoft Windows XP, Vista 7 and Mobile 5.0+ 
� KDC Device Driver   
� User Manual 

 [NOTE]:  Depending on your region or distributor, package contents may vary. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1- KDC Package 

KDC30 
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 KDC Characteristics 1.2 

 

Before you use your KDC, please become familiar with its physical characteristics. 

Refer to Figure 2 below which indicate placement of SCAN, UP and DOWN buttons, 

LEDs, and ports on your KDC. KDC30 does not include LCD screen since it is 

designed as the simplest barcode scanner to use without LCD screen.  

 

KDC30 Barcode Reader and Data Collector 

 

 

  

 

 

 

 

 

 

 

           

 

Green/Red/Orange LEDs 

UP Button 

DOWN Button 

SCAN Button 

DELETE Button 

Type A USB-swings out  

KDC30 

Figure 2 – Characteristics of KDC30 
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2. Installation 
 

 Bluetooth Pairing 2.1 

KDC itself reads barcodes independently, and it can also be used in combination with PC, 

PDA, or smart phones. When you want to read barcodes with KDC in connection with 

other devices, you need to conduct pairing between your KDC and smart phone via 

Bluetooth first. Unless there are changes in Bluetooth settings, your smart phone will 

always recognize your KDC that has already been paired. However, if you change 

Bluetooth settings, you need to go through pairing process for your KDC again. You can 

also refer to Chapter 4. BLUETOOTH for more information about Bluetooth pairing.  

 

2.1.1 Preparing for Pairing 

1. Turn on the power first if you are a KDC30 user. 
 
 
 
 
 
 
 
 
 
 
 
 

2. Set a Bluetooth device type mode. There are two ways to set a Bluetooth device 
type mode.  

 
 

� Select and scan your Bluetooth device type barcode among the barcodes below, or  
 

 
Bluetooth Profile SPP                    Bluetooth Profile HID iOS 

       

Bluetooth Profile IPHONE                  Bluetooth Profile SPP2.0 

Press SCAN and DOWN 

buttons simultaneously for 5 

seconds.  You will hear beep 

sound when it is turned on. 

Figure 3 – How to turn on the power in KDC30 
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Press SCAN Button for 3 seconds 

        

Bluetooth Profile HID normal 

 

 

 

 

2.1.2 Pairing 

 

Way One:  Connect your KDC from your smart phone or PDA 
This method is recommended for first-time users or when you are only 

connecting a few KDCs.  

 

 

1. Put your KDC into Pairing mode  
 
� Select and scan a pairing barcode below according to your KDC model, or  

 
KDC 30 

   
                                                                                            

 

 

   Pairing 

 

 
 
� Press Scan button for three seconds to enter Pairing mode.    
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2. On your host device, go to Settings->Bluetooth, find the KDC with which you want to 
pair and select it. Your KDC and host device are now communicating each other.  

                                                                   

 

 

 

  

                                       

 

                                                         Tap Bluetooth                     Tap your KDC  

 

3. Open KTSync after it has been installed and it will automatically find the KDC and 

connect. (Refer to 2.2 KoamTac Installation Wizard for more information about installing 

KTSync)  

 

 

 

Way Two: Connect your host device from your KDC by scanning   a 
Special Bluetooth MAC Address barcode 

 

The method is recommended for more advanced users or when your application or 

process calls for pairing one of many KDCs to one of many host devices on a regular 

basis.  

 

1. Find the Bluetooth MAC Address of your host device.  

 

                                                                  

 

 

 

 

     

Settings 

Settings 

Figure 5 – Pairing mode button in KDC30 
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                                           1. Tap on General        2. Tap on  About      3.  Bluetooth address  

 

Figure 6 – Finding Bluetooth Mac Address  

2. Create your Bluetooth MAC Address Barcode according to the format below.  

Bluetooth MAC Address: 1234567890AB    
Barcode Type (Symbology): Code 128  

Contents: ^FNC3651234567890AB                       

Options: includetext parsefnc 
                
 
 

3. Print your Bluetooth MAC Address   
 
Note: Laser scanners like KDC30 is not designed to read from a LCD screen and will only 
read the printed barcode.   

 
 

4. Connect your KDC to your host device by scanning the Bluetooth MAC Address 

Barcode. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7 - Connecting KDC with a smart phone by scanning Bluetooth MAC Address Barcode  

 

Tap on Bluetooth 
Scan the  

BT MAC Address  Barcode 

Tap on Pair Complete! 

Settings 
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5. Open KTSync after it has been installed and it will automatically find the KDC and 

connect. (Refer to 2.2 KoamTac Installation Wizard for more information about installing 

KTSync)  
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 KoamTac Installation Wizard 2.2 

 

2.2.1 Windows 7 and 8 

WARNING:  DO NOT CONNECT KDC TO USB PORT PRIOR TO INSTALLATION 

1. Insert KoamTac Installation CD into your computer’s CD drive.   

2. Click Start icon then My Computer icon.  A listing of devices on your 

computer will be displayed including the disk drive containing the KoamTac 

Installation CD.   

3. Click on the KoamTac Installation CD icon then click on the Setup directory.  

Click on the PC_Setup.exe file which executes the KTSync Setup Wizard. 

Note: 

•  If KTSync Setup Wizard locates an older version of KTSync on your 
computer, you will be prompted to remove the older program before 
installing the new version.  Select Remove KTSync then click Finish.  When 
removal is complete, click Close.  Go to Step 2 to run KTSync Setup Wizard.  

• If you have any problems, please refer to 2.3 Manual Installation. 

 

KTSync Setup Wizard 

Follow the steps to install KTSync as images below.  

 

� Click Next icon in KTSync Setup Wizard window

 



KDC User Manual 

 

22 
Revision 3.05.R6 

Copyright ® 2014, KoamTac, Inc. 

 

� Check” I Agree” and Click Next icon in License Agreement window 

 

 
 

 

� Click Close icon in KTSync Installation Complete window and wait for Device 

Driver Installation Wizard  
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� Click Install this driver in Windows Security window and installation is 

finished. 

 
 

Connect KDC to Computer 

Using the USB cable included with the KDC, follow the directions below. 

� Connect mini USB connector to the KDC. 

� Connect Type A USB connector to your PC. 

� Wait until your computer beeps and/or displays the message Found New 

Hardware. 

 

Verify COM Port Address 

� User can verify installed COM Port in Device Manager 
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2.2.2  Windows Mobile 5.0+ 

 

WARNING:  PLEASE CONNECT PDA TO PC PRIOR TO INSTALLATION 

1. PC_Setup.exe creates Mobile_Setup.exe file under C:\Program 

Files\KoamTac\KTSync\Windows.Mobile directory 

2. Execute Mobile_Setup.exe 

 

� Select Windows Mobile version to install. 

 

 
 

� Click Next icon. 
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� Click OK icon in Pending Application Install window 

 

 
� Follow the instructions on PDA screen 

 

COM port Assignment 

 

� User should assign a COM port for KDC before using pKTSync. 

� User should pair KDC with PDA using PDA Bluetooth manager and assign a 

COM port for Bluetooth communication 

� Please refer to the PDA manual for the details of COM port assignment 

method 
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2.2.3 Android 

 

� Download and install aKTSync from the Android Play Store 

https://play.google.com/store/apps/details?id=com.koamtac.ktsync&hl 

2.2.4 Blackberry 

 

� Download and install bKTSync from the Blackberry App World. 

http://appworld.blackberry.com/webstore/content/16861?lang=en 

 

2.2.5 iPad/iPhone/iPod touch 

 

� Download and install iKTSync from the Apple App Store. 

http://itunes.apple.com/us/app/ktsync/id372916602?mt=8 
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 Manual Installation 2.3 

 

2.3.1 Windows XP/Vista7/8 

1. Insert the KoamTac Installation CD into your computer’s disk drive.   

2. Create a directory called KoamTac on your computer. 

3. Copy XP.Vista.7 directory from KoamTac CD to KoamTac directory. The 

XP.Vista.7 directory contains KTSync® programs for Microsoft® Windows XP, 

Vista, Windows 7 and user manuals. 

4. Connect KDC cable to ultra mini USB connector on the KDC. 

5. Connect KDC cable to Type A USB connector on your computer. Wait until 

your computer beeps and/or displays the message New Hardware Found. 

You will be prompted to search for a device driver for KDC. 

6. Browse then select KTReader.inf file from the KoamTac directory created in 

Step 2. Follow screen prompts to continue with the device driver installation.   

Note: 

•  KTReader.inf is the device driver for 32bit Microsoft® Windows XP, Vista, 
and Windows 7. If you have a 64bit computer, use KTReader.inf file from 
XP.Vista.64bit folder in the KoamTac directory. 

 

2.3.2 Windows Mobile 5.0+ 

Connect Windows Mobile PDA with your computer to install KTSync program.   

1. Create a KoamTac folder in your PDA.  

2. Copy the Mobile5.0_6.0 folder in KoamTac CD and paste it in the PDA 

KoamTac folder that was created in My Computer.  

3. In the Mobile5.0_6.0 folder, you will find KTSync® Programs for Microsoft® 

Windows Pocket PC 2003, Mobile 5.0, Mobile 6.0 Standard, and Mobile6.0 

Professional as well as KDC User Manual.   
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3. Operating the KDC  
 

 

 Getting Started 3.1 

 

3.1.1 Attach Lanyard/Hand strap to KDC 

To prevent possible damage to the KDC, we strongly recommend wearing it around 

your neck or hand by the included Lanyard/Hand strap.  Also, please don’t swing KDC 

by the Lanyard/Hand strap because contact with another object may cause it to 

malfunction or become damaged.  

To attach the Lanyard: 

1. Fit the thin end of Lanyard through the pillar of the KDC. 

2. Loop the thick end of strap through the thin loop 

3. Pull the strap tight to secure  

 

3.1.2  Charge KDC Battery 

Prior to using the KDC, you must charge its battery. It will take approximately 2 hours to 

charge your KDC30.   To charge the battery, follow the directions below. 

 

1. Connect the KDC cable to the mini USB connector on the KDC. 

2. Connect the KDC cable to Type A USB connector on your computer. 

3. Your KDC battery will begin charging. Within a few minutes, two small LEDs on 

the front panel will illuminate orange.  When the battery is fully charged, the 

LEDs will illuminate green. 

 

 

3.1.3  Configure KDC 

The KDC is designed to meet the data collection requirements of many different 

industries in a variety of dynamic situations.  To perform well in these diverse 

environments, the KDC is designed to be configured easily and quickly.  But, to perform 
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at its maximum level, the KDC must be configured properly.  Until you are familiar with 

configuring the KDC, it is recommended that you DO NOT modify the KDC settings.  

The KDC can be configured using three different methods which are explained in 

Section 3.3 – KDC Menus, Chapter 4 –Synchronization, and 10. Appendix C – Special 

Barcodes.   

 

CONFIGURATION METHODS FOR THE KDC30  

� KTSync®  Software 

� Special Barcodes 
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  Basics  3.2 

 

3.2.1 Reading Barcodes 

Reading a barcode is simple. Point the KDC at a barcode and press the scan button. Be 

sure to point the scan engine window at the barcode, not at your face, and make sure to 

position the light beam on the barcode. If the barcode is scanned successfully, you will 

hear one beep and the LEDs will illuminate in green. The scanned barcode data will be 

displayed along with the scan time and battery level. Depending on the configuration of 

your KDC, other information may also be displayed. 

 

 

 

  

 

 

 

Figure 10 – Scanning barcodes with KTSync 

If the scanning was unsuccessful, you will hear two beeps, the LEDs will illuminate in red, 

and the message Failed reading… will display. If you have problems with KDC in 

scanning a barcode, try the following suggestions while pointing the KDC at the 

barcode and pressing the scan button. 

� Modify the angle of the KDC in relation to the barcode, making the angle 
bigger or smaller as needed. 

� Modify the distance between the barcode and the KDC, moving closer or 
further away as needed. 

� Check option settings defined in the KDC menu section and change options as 
needed. 

� Check that the barcode’s width does not exceed the light beam’s width and vice 
versa. 
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3.2.2 Delete Data Function in KDC30 

You can delete the last scanned barcode by pressing the DELETE button on the right 

side of your KDC30 although it does not have LCD screen to view the data.   

 

  

 

 

 

  

 

3.2.3 Synchronizing Data to the host device 

Use the KTSync® program to synchronize barcode data from the KDC to your host 

device. Please refer to Chapter 6. Synchronization for details. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Press Delete button to delete the barcode 

scanned at the very end. 

Figure 11 – Delete Function in KDC30 
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 KDC Menus 3.3 

Top Menu Sub Menu Options KDC30 

KDC Mode Normal  Default 

Application  N/A 

View Data View/Delete  N/A 

Set Barcodes 

 

1D Symbology Codabar Enabled 

 Code 11 Enabled 

 Code 32 Enabled 

 Code 39 Enabled 

 Code 93 Enabled 

 Code 128 Enabled 

 EAN-8 Enabled 

 EAN-13 Enabled 

 GS1 Composit Enabled 

 I2of5 Enabled 

 Matrix 2of5 Enabled 

 MSI Enabled 

 Plessey Enabled 

 PosiCode Enabled 

 GS1 Omni Enabled 

 GS1 Limited Enabled 

 GS1 Expanded Enabled 

 S2of5 Ind Enabled 

 S2of5 IATA Enabled 

 TCL39 Enabled 

 Telepen Enabled 

 Trioptic Enabled 

 UPCA Enabled 

 UPCE0 Enabled 

 UPCE1 Enabled 

2D Symbology AztecCode Enabled 

 AztecRunes Enabled 

 CodablockF Enabled 

 Code16K Enabled 

 Code49 Enabled 

 DataMatrix Enabled 

 MaxiCode Enabled 

 MicroPDF Enabled 

 PDF417 Enabled 

 QRCode Enabled 

 HanXin Code Enabled 

Postal Codes Postnet Enabled 

 PlanetCode Enabled 

 UK Post Enabled 

 Canada Post Enabled 

 Kix Post Enabled 

 Australia Post Enabled 

 Japan Post Enabled 

 China Post Enabled 

 Korea Post Enabled 

OCR OCR Off Enabled 

 OCR A Disabled 

 OCR B Disabled 

 OCR USC Disabled 

 OCR MICR Disabled 

 OCR SEMI Disabled 
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Barcode Options 

 

Codabar Tx StartStop(Enabled/Disabled) Disabled 

 Check 

Digit(DoNotVerify/VerfyDONotTX/V

erifyDoTx) 

DoNotVerify 

 Concatenate(Disabled/Enabled/Req

uired) 

Enabled 

Code39 Tx StartStop(Enabled/Disabled) Disabled 

 Check 

Digit(DoNotVerify/VerfyDONotTX/V

erifyDoTx) 

DoNotVerify 

 Append(Enabled/Disabled) Disabled 

 Full ASCII(Enabled/Disabled) Disabled 

I2of5 Check 

Digit(DoNotVerify/VerfyDONotTX/V

erifyDoTx) 

DoNotVerify 

Code11 Check Digit(2 digits/1 digit) 2 digits 

Code128 Concatenate(Disabled/Enabled) Disabled 

Telepen Output(Original/AIM) AIM 

UPCA VerifyChkDgt(Enabled/Disabled) Enabled 

 NumberSys(Enabled/Disabled) Enabled 

 2DgtAddenda(Enabled/Disabled) Disabled 

 5DgtAddenda(Enabled/Disabled) Disabled 

 Req. Addenda(Enabled/Disabled) Disabled 

 Sep. Addenda(Enabled/Disabled) Enabled 

 Coupon Code(Enabled/Disabled) Enabled 

UPCE Expand(Enabled/Disabled) Disabled 

 Req. Addenda(Enabled/Disabled) Disabled 

 Sep. Addenda(Enabled/Disabled) Enabled 

 Check Digit(Enabled/Disabled) Enabled 

 NumberSys(Enabled/Disabled) Enabled 

 2DgtAddenda(Enabled/Disabled) Disabled 

 5DgtAddenda(Enabled/Disabled) Disabled 

EAN-13 VerifyChkDgt(Enabled/Disabled) Enabled 

 2DgtAddenda(Enabled/Disabled) Disabled 

 5DgtAddenda(Enabled/Disabled) Disabled 

 Req. Addenda(Enabled/Disabled) Disabled 

 Sep. Addenda(Enabled/Disabled) Enabled 

 ISBN Trans.(Enabled/Disabled) Disabled 

EAN-8 VerifyChkDgt(Enabled/Disabled) Enabled 

 2DgtAddenda(Enabled/Disabled) Disabled 

 5DgtAddenda(Enabled/Disabled) Disabled 

 Req. Addenda(Enabled/Disabled) Disabled 

 Sep. Addenda(Enabled/Disabled) Enabled 

MSI Tx CheckChar(Enabled/Disabled) Disabled 

PosiCode A and B/A&B LimitedA/A&B 

LimitedB 

A&B LimitedB 

GS1 UPCEAN Ver.(Enabled/Disabled) Disabled 

 GS1 Emulation(No Emulate/GS1 

128 Emul/GS1 Emulate) 

No Emulate 

PostNet Tx CheckChar(Enabled/Disabled) Disabled 

PlanetCode Tx CheckChar(Enabled/Disabled) Disabled 

Scan Options Scan Angle Narrow/Wide N/A 

Filter Normal/High N/A 

Time Out .5 seconds to 10 seconds 2 second(s) 

Min. Barcode Length 2 to 36 characters N/A 
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Min. Barcode Length 2 to 48 characters 4 chars 

Security Level 1 to 4 level N/A 

Image Capture Enabled/Disabled Disabled 

Auto Trigger Enabled/Disabled Disabled 

Reread Delay Continuous, Short, Medium, Long, 

Extra Long 

Medium 

Finger Trigger Enabled/Disabled N/A 

Partial Display Start Position 1 

 No. of Char(s) 0 chars 

 Action Select 

Data Process Wedge / Store Wedge Only  

 Wedge & Store Always Default 

 Store Only  

 Save if Sent  

 Save if Not Sent 

Data Format Barcode only Default 

 Packet Data  

Data Editor/Prefix Delete Delete 

Data Editor/Suffix Delete Delete 

Data Editor/AIM ID None/In Prefix/In Suffix None 

Data Editor/Partial Data Start Position 1 

 No. of Char(s) 0 chars 

 Action Select 

Handshake Enable/Disabled Disabled 

Terminator None, CR, LF, CR+LF, Tab, Right 

Arrow, Left Arrow,Down Arrow, Up 

Arrow 

CR+LF 

 Chk Duplicate Enabled/Disabled Disabled 

 Enter Key Enabled/Disabled N/A 

BT Config ConnectDevice 

(Non Mfi mode) 

SPP Default 

  HID iOS  

  SPP2.0  

  HID normal  

 ConnectDevice 

(Mfi mode ) 

SPP  

  iPhone Default 

 Auto Connect Enabled/Disabled Disabled 

 Auto Reconnect Enabled/Disabled Disabled 

 Auto Power On Enabled/Disabled Disabled 

 Auto Power On/Power On Time disabled, 1sec to 10second(s) Disabled 

 Auto Power Off Enabled/Disabled Disabled 

 Auto Power Off/Beep Warning Enabled/Disabled Disabled 

 Auto Power Off/Power Off Time 1 to 30 minutes Disabled 

 PowerOff Msg Enabled/Disabled Disabled 

 MAC Address 12 Characters Bluetooth MAC Address 

 BT FW Version v1.2.xrt Bluetooth Firmware Version 

 Wakeup Nulls Enabled/Disabled Disabled 

 Connect Alert Enabled/Disabled Disabled 

 BT Toggle Enabled/Disabled Enabled 

 DisconnectBtn Enabled/Disabled Enabled 

 HID AutoLock disabledd,1,2,3,4,5,10,15 minutes 1 minutes 

 HID Keyboard US,German,French,Italian,Spanish US 

 HID Delay/Initial Disabled, 1,2,3,5,10 secs Disabled 

 HID Delay/Inter char Disabled,10, 20, 30, 50, 100msec Disabled 

 HID Ctrl Char Disabled, Alt+Numpad, 

^+Character, Replace to | 

Disabled 

BT Service Power Enabled/Disabled Enabled 

 Pairing Pairing neighboring Bluetooth devices 
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 Discovering Discovering neighboring Bluetooth devices 

 Connecting to View Connect to Bluetooth device 

 HID Sync   

USB Config-USB Serial Mode 

(M model) 

USB Mode USB Serial/USB Disk USB Serial 

System 

Config 

Memory Size(3.0 only) 0.5/3.5, 1/3, 2/2, 3/1, 4/0 N/A 

 Memory Status No. of Stored Barcodes 

  Free Memory Available 

 Reset Memory Memory(Empties Data) 

  Application Memory 

    

 Auto Erase Enabled/Disabled Disabled 

 Sleep Timeout Disabled, 1sec to 10minute(s) 5 second(s) 

 Date / Time YYYY:MM:DD & 

  HH:MM:SS  

 Battery   

 Version   

 Button Lock Enabled/Disabled N/A 

 Beep Alert /Beep Sound Enabled/Disabled Enabled 

 Beep Alert /Power On Beep Enabled/Disabled Enabled 

 Beep Alert /Beep On Connect Enabled/Disabled Enabled 

 Beep Alert /Beep On Scan Enabled/Disabled Enabled 

 Beep Volume Low/High Low 

 Mfi 

( i-chip installed) 

Enabled/Disabled Enabled 

 Auto Exit Enabled/Disabled N/A 

 Port Status Enabled/Disabled N/A 

 Display Format Time & Battery / Type & Time / 

Type & Battery / Memory Status / 

GPS Data(KDC250 only)/Barcode 

Only 

N/A 

 Menu Barcode Enabled/Disabled N/A 

 Scrolling Enabled/Disabled N/A 

 Brightness 1 to 15 level(8 level) N/A 

 Factory Default   

 

Table 2 – KDC30 Menu Options 

 

3.3.1 Set Barcodes Menu 

This menu lists all the barcode symbologies supported by your KDC and allows you to 

select the barcode symbologies you will be scanning. For maximum scan performance, 

you should select only the symbologies you are scanning. Please refer to 11. Appendix – 

11.1 Symbologies for a detailed listing of symbologies supported by your KDC. 

 

3.3.2 Code Options Menu 

Your KDC supports various Code Options including Transmission of Start and Stop 

Characters, Symbology Conversion, Verification of Optional Check Character, and 
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Transmission of Check Digit. Please refer to 11. Appendix A – 11.2 Code Options for a 

detailed explanation of each option. 

 

3.3.3 Scan Options Menu 

� Scan Angle (Opticon model only): Allows you to configure the laser beam angle 

to the barcode. There are two options for scan angle: Wide and Narrow. Wide is 

54o and Narrow is 27o. The default is Wide. 

� Filter (Opticon model only): Allows you to change the Filter mode from Normal 

to High for poor quality barcodes. The default is Normal. 

� Timeout: Allows you to set the interval between one scanning and the other. The 

timeout options are from 5 seconds up to 10 seconds. The default is 2 seconds. 

� Minimum Barcode Length: Allows you to set a barcode length from 2 characters 

to 36 characters. It is strongly recommended that you maximize the minimum 

barcode length setting to prevent possible errors. The default minimum barcode 

length of KDC30 is 4 characters. 

 

 
Minimum (Default) Maximum (Default) 

1D 

Symbology 

Codabar 2(4) 60(60) 

Code 11 1(4) 80(80) 

Code 32 
  

Code 39 0(0) 48(48) 

Code 93 0(0) 80(80) 

Code 128 0(0) 80(80) 

EAN-8 
  

EAN-13 
  

GS1 Composit 
  

I2of5 2(4) 80(80) 

Matrix 2of5 1(4) 80(80) 

MSI 4(4) 48(48) 

Plessey 4(4) 48(48) 

PosiCode 2(4) 80(48) 

GS1 Omni 
  

GS1 Limited 
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GS1 Expanded 4(4) 74(74) 

S2of5 Ind 1(4) 48(48) 

S2of5 IATA 1(4) 48(48) 

TCL39 
  

Telepen 1(1) 60(60) 

Trioptic 
  

UPCA 
  

UPCE0 
  

UPCE1 
  

2D 

Symbology 

AztecCode 1(1) 3750(3750) 

AztecRunes 
  

CodablockF 1(1) 2048(2048) 

Code16K 0(1) 160(160) 

Code49 1(1) 81(81) 

DataMatrix 1(1) 1500(1500) 

MaxiCode 1(1) 150(150) 

MicroPDF 1(1) 366(366) 

PDF417 1(1) 2750(2750) 

QRCode 1(1) 3500(3500) 

HanXin Code 
  

Postal Codes 

Postnet 
  

PlanetCode 
  

UK Post 
  

Canada Post 
  

Kix Post 
  

Australia Post 
  

Japan Post 
  

China Post 2(4) 80(80) 

Korea Post 2(4) 80(48) 

OCR 

OCR Off 
  

OCR A 
  

OCR B 
  

OCR USC 
  

OCR MICR 
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OCR SEMI 
  

� Security Level: Allows you to ensure an accurate barcode reading by setting the 

number of times the KDC will read a barcode.  Security Level is set from 1 up to 4.  

The higher security level means more reliable readings though some 

performance degradation is likely. For poor quality barcodes, we recommend 

increasing the security level.  The default is 2. 

� Auto Trigger: Allows users to scan a barcode automatically once Auto Trigger is 

enabled. User can adjust Reread delay from Continuous to Extra Long. Auto 

Trigger mode always enables duplicate check option.  

[Note1] USB cable insertion requirement is removed from FW2.85/86.O and FW 

3.02. 

 

[Note2] Users can exit the auto trigger mode by pressing the scan button for 3 

seconds. 

� Reread Delay: Users can adjust Reread delay from Continuous to Extra Long. 

Auto Trigger mode always enables duplicate check option. 

� Partial Display: Allows you to display partial data. User defines the start position 

and number of characters to be displayed. 

 

3.3.4 Data Process Menu 

Wedge/Store - The KDC provides five modes of data transmission in keyboard wedging 
mode. 
 
 

� Wedge Only:  Barcode data is NOT stored in memory but transmitted to the host. 
 

� Wedge & Store Only: Barcode data is stored in memory and transmitted to the 
host. 
 

� Store Only:  Barcode data is stored in memory but NOT transmitted to the host. 
 

� Save if Sent:  If data transmission is successful, barcode data is stored in memory. 
 

� Save if Not Sent:  If data transmission is NOT successful, barcode data is stored in 
memory. 
 
 

Data Format - The KDC provides two data formats, Barcode Only and Packet Data. 
 

� Barcode Only: KDC transmits scanned barcodes only. User may incorporate 
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proper data transmission error detection and correction mechanism in this 

mode. 

� KDC supports various termination characters for barcode only format. 

� User can select <NONE>, <CR>, <LF>, <CR+LF> or <TAB> as the 

termination character. 

� Packet Data: KDC transmits packet data with checksum to minimize 

transmission errors. 

�    KTSync® sets Data Format to Packet Data format upon execution. 

User may change Data Format to Barcode only if user prefers to use 

Barcode only mode but either KTSync program terminates 

abnormally or user disconnects KDC without exiting KTSync program 

normally.  

Note: 

•  Barcode Index: KDC30i add 4 bytes barcode index to maintain last synchronized 
barcode information.  

1) This optional index would be added if data format is “Packet Data”.    

2) 4 bytes index would be added before “@” when responding to “p” command. 

3) 4 bytes index plus “@” character would be added after checksum byte if user scan a 
barcode and wedging to the host. 

 

Data Editor - KDC provides various data editing options. 

� Prefix - Allows you to add a prefix to scanned data which can then be stored 

in KDC or wedged to the host. The Prefix format must be defined in the data 

format menu of KTSync. The maximum length for a Prefix is 11 characters. 

� NOTE:  This Prefix option is different from the Prefix option in KTSync 

which appends the prefix to data during synchronization.   

 

� Suffix - Allows you to add a suffix to scanned data which can then be stored in 

KDC or wedged to the host. The suffix must be defined in the data format 

menu of KTSync. The maximum length for a suffix is 11 characters.  
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� NOTE:  This Suffix option is different from the Suffix option in KTSync 

which appends the suffix to data during synchronization.   

 

� AIM ID - Allows you to add AIM ID to scanned data which can then be stored 

in KDC or wedged to the host. AIM ID must be defined in data format menu 

of KTSync. AIM ID is either added to the end of Prefix or Suffix. 

� Partial Data: Allows you to store and/or transfer partial data. User defines the 

start position and number of characters to be stored and/or transferred. 

o Select the x characters from y position 

- Set Partial Data Start Position to y, Partial Data Length to x, Partial 
Data Action to Select 

- Partial Data Length 0 means to select all characters from y position. 

o Erase the x characters from y position 

- Set Partial Data Start Position to y, Partial Data Length to x, Partial 
Data Action to Erase 

- Partial Data Length 0 means to erase all characters from y position. 

Handshake - KDC provides Handshake mode when Data Format is set to Packet Data. 

� Handshake Mode will increase the reliability of barcode data transmission. 

� The default mode for Handshake is Disabled. 

� Data transmission speed is slower when Handshake Mode is Enabled. 

 
Terminator – KDC supports various termination characters when the Data Format mode 

is set to Barcode Only.  This option allows you to select <NONE>, <CR>, <LF>, 

<CR+LF>, or <TAB> as the termination character. The default terminator is <CR+LF>. 

Up/Down/Left/Right arrow terminator is also available for HID mode. 

Chk Duplicate – This option allows you to prevent collecting duplicated data. 

 

3.3.5 BT Config Menu  

The KDC supports Bluetooth Ver2.1+EDR. Before utilizing the advantages of Bluetooth 

functionality with the KDC, you should become familiar with Bluetooth connectivity and 

its impact on your host environment.  
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To configure your KDC for Bluetooth functionality, you must use the KDC Menus. To 

access the menus, simultaneously press the UP and DOWN buttons on the side of the 

KDC. Use the DOWN button to scroll to Bluetooth then press SCAN button.  

Below is a listing of the Bluetooth options and their settings. The default settings for 

these options have been set to increase the usability of Bluetooth technology without 

compromising the KDC battery usage.  

 

IMPORTANT: We strongly recommend NOT changing these settings until you have fully 

tested the Bluetooth connection between the KDC and the host device.  

 

For more detailed information regarding Bluetooth functionality with the KDC, please 

refer to Chapter 4. BLUETOOTH. 

 

� ConnectDevice: Users can choose  Bluetooth device type  
Options - HID normal (KDC30) 

- HID iOS (KDC30) 

- SPP2.0  

- SPP(KDC30/30i) 

- iPhone (KDC30i) 

� Auto Connect : Enabled or Disabled  

� Auto Reconnect: Enabled or Disabled (iPhone, HID iOS, HID normal mode) 

� Auto Power On: Enabled or Disabled  

� PWR On Time: Disabled, 1 to 10 seconds  

� Auto Power Off :  Enabled or Disabled  

� Beep Warning - Enabled or Disabled  

� PWR Off Time - 1 to 30 Minutes  

� PowerOff Msg – Enabled or Disabled 

� MAC Address – 12 characters Bluetooth MAC Address  

� FW Version –  Display Bluetooth Firmware Version 

� Wakeup Nulls – Enabled or Disabled 

� Autolock Time – 0, 1, 2, 3, 4, 5, 10, 15 minutes 

� BT Toggle – Enable or Disable HID soft keyboard or iPhone mode 

connection On/Off toggle. 

� BT Disconnect Button – Enable or Disable Bluetooth disconnection by 

pressing down button for 3 seconds. 

� HID AutoLock - Disabled, 1, 2, 3, 4, 5, 10, 15 minutes 

� HID Keyboard – English, German, French, Spanish, Italian 

� HID Initial Delay- Define the initial delay between 1 second to 10 seconds 

before data transmission in HID mode 

� HID Inter-character Delay - Define the inter-character delay between 10msec 
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to 100msec in HID mode 

� HID Control Character - Map control characters to either ALT+Numlock or 

^+Character. 

 

3.3.6 BT Service  

� Power : Turning on or off Bluetooth Power 

Options – Enable/Disable 

� Pairing Mode 

- KDC enters pairing mode so that host Bluetooth device can search KDC. 

- KDC exits pairing mode either by pressing SCAN button or it fails to pair 

with Bluetooth host device in 90 seconds. 

� Discovering: Search neighborhood Bluetooth devices 

� Connecting To: Inquiry to registered Bluetooth devices  

� HID Sync: KDC transmits all stored data to the host over HID profile if HID 

Sync option is enabled 

 

3.3.7  System Menu 

� Memory Size (3.0 version only) 

� User can select normal data and application database memory partition size. 

� KDC will erase all stored data upon changing the partition size. 

� User should enter the following key sequence to change the partition. 

� UP button + UP button + DOWN button + DOWN button + SCAN button 

� Memory Status:  Checks the number of stored barcodes and memory usage. 

� Reset Memory: Resets KDC memory by erasing all stored barcodes, application 

and BT registry. 

� Auto Erase: Erases all stored barcodes upon reaching buffer full condition if 

Enabled is selected 

� Sleep Timeout: Sets amount of time KDC waits, when not being used, before 

going to sleep.   

� Date/Time: Sets the date and time of KDC which can also be set using KTSync® 

� Battery: Shows current status of battery power level. 

� Version: Shows KDC firmware version and serial number. 

� Button Lock: Locks or unlocks KDC scan and scroll buttons. 

� Beep Alert 

� Beep Sound: Enables or disables KDC beep sound. 

� Power On Beep: Enables or disables beep sound when KDC power is on. 

� Beep On Connect: Enables or disables beep sound when KDC is connected to 

host. 
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� Beep On Scan: Enables or disables beep sound when KDC is scanning. 

� Beep Volume: High or low. 

� MFi Mode (KDC30i): Enables or disables MFi mode. MFi mode supports SPP and 

iPhone Bluetooth profiles. Non-MFi mode supports SPP, SPP2.0, HID iOS and HID 

normal. 

� Vibrator: Enables or disables KDC vibrator. 

� Auto Exit: Enables KDC to automatically exit KDC Menus. 

� Port Status: Enables or disables KDC port messages. 

� Display Format: Selection of display format - Time & Battery, Type & Time, Type & 

Battery, Memory Status and Barcode only 

� Scrolling : Enables or disables display scrolling for a barcode with more than 40 

characters 

� Brightness: Adjusts display brightness 

� Factory Default: Resets KDC options to factory default settings. 

 

3.3.8 Pair and connect KDC30iand iOS4.0+ in HID mode 

Note: 

•   Users have to disable MFi option in System > MFi menu to use HID 
Bluetooth profiles. 

• Users have to RESET the iPhone/iPad/iPod touch to change HID to iPhone 
mode, and vice versa, after removing previous KDC connection. 

• KDC with Bluetooth Spec2.1+EDR doesn’t prompt Pin code entry menu. 

• KDC with Bluetooth Spec. 2.1+EDR stack doesn’t require 4 or 6 digits PIN 
digits entry 

Follow the steps to pair and connect KDC models for MFi and iOS4.0 in HID mode.  

1. Go to the KDC System > MFi menu. 

2. Change MFi option to Disabled. 

3. Change KDC to Pairing mode. 

4. The iPhone/iPad/iPod touch will find a new device as Keyboard. 

5. Click Keyboard device. 

Note: 

•   Please skip the following steps if iPhone/iPad/iPod touch doesn't ask for the 
PIN number. 

6. Click Keyboard device: The iPhone/iPad/iPod touch will ask for the PIN number. The 

iPad will ask for 6 digits and the iPhone/iPod touch will ask for 4 digits. 
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7. As soon as the iPhone/iPad/iPod touch asks for the PIN number, KDC will display the 

PIN digits selection menu. By default, it is 6 digits. 

8. Press SCAN button to select the 6 digit PIN code for the iPad. Press DOWN button 

and then SCAN button to select the 4 digit PIN code for the iPhone/iPod touch. 

9. The iPhone/iPad/iPod touch will display the PIN code that users should enter into the 

KDC. 

10. By default, the KDC displays pin codes 555555(5555). Users can change the PIN code 

by using UP button on the side of the KDC unit to increase numbers, DOWN button 

to decrease numbers, and SCAN button to confirm and move to the next digit. 

11. Once the last PIN number is entered, press and hold SCAN button for a few seconds. 

KDC will display HID connected message and the iPad/iPhone/iPod touch will 

display Connected message if paired successfully. 

3.3.9 iOS Soft Keyboard toggling using BT Toggle option 

1. Users need to select the option to use this feature in the BT Config > BT Toggle. 

2. Press DOWN button to disconnect the HID connection and bring a soft keyboard                    

(If DisconnectBTN option is enabled). 

3. Press UP button to connect HID 

4. The BT toggle is a useful feature if users desire to use both the KDC and soft keyboard. 
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 LED Status  3.4 

 

 

 

 

 

 

 

Table 3 - Explanation of LEDs 

 

 Empty Battery 3.5 

• Under 30% - Orange LED flickers at 1-second-interval for 5 seconds every minute.   
• Under 20% - Orange LED flickers in 1- second-interval for 10 seconds every 

minute.  
• Under 10% - Red LED flickers in 1- second-interval for 10 seconds every minute 

and you will hear beeping sound. 
 

 

 Buffer Full 3.6 

KDC30 Users will hear a beep when the size of collected data reaches 160KB (85 version) 

/ 60KB (86 version) or the number of collected barcodes is 10,240. To prevent the loss 

of data, you should synchronize the data then reset the memory when this message 

displays. 

 

 Power-on/off  3.7 

You can turn the power on and off by pressing DOWN and SCAN button simultaneously 

for 5 seconds. When the LED light is in green, you can release the buttons and the 

 LED Color Status 

Green 

� Successful Reading 

� USB is connected and battery is fully 
charged 

� iPhone mode in pairing mode  

Orange 

� Low battery 

� USB is connected and battery is charging 

� HID mode in pairing mode  

Red 
� No reading 

� SPP mode in pairing mode  
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1 

 

Unscrew the screw indicated by the arrow. 

2 

 

Remove the battery cover by pulling it 

down. 

3 

 

Remove the battery. 

Pull out the 2 pin connecter gently. 

 

power is on.  When you turn off your KDC30, you will hear a beep sound after you press 

DOWN and SCAN buttons simultaneously.  

 

 Replace Battery 3.8 

KDC comes with a rechargeable, Lithium-polymer battery. The battery is recharged from 

any USB port or KDC charging cradle and can be recharged about 300 times before it 

needs to be replaced.  KoamTac recommends replacing the battery every six months as 

a declining battery will cause noticeable performance degradation in KDC. Replacement 

batteries can be purchased from a KoamTac distributor. Batteries should be disposed 

properly according to the WEEE regulation. The steps for replacing the battery are as 

follows. 

1.        Disassemble the KDC back cover by unscrewing the middle screw.  

2.        Remove old battery and replace with new battery. 

3.        Reassemble the back cover. 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 12 - Replacing Battery 
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4. BLUETOOTH  

The KDC30 support HID (Human Interface Device) normal, HID iOS, SPP (Serial Port 
Profile) and SPP2.0 profiles. KDC30i support SPP and iPhone (Made for iPhone) profiles. 
They are compatible with the following Bluetooth stacks. 
 

� BlueSoleil  
� Broadcom (Widcomm)  
� Microsoft Windows XP, Vista, 7, and Mobile5.0+ 
� Toshiba 

KDC30 can configure Bluetooth options using PC KTSync and special barcodes. 

 
 
 

 Bluetooth Config 4.1 

 
 

4.1.1 ConnectDevice  

KDC supports both Serial Port Profile (SPP) and Human Interface Device Profile (HID). User 

can choose SPP2.0, SPP (2.1), HID normal, HID iOS profiles to communicate with the host 

device. Additional iPhone (Made for iPhone) option is available for KDC30i. 

 

User can connect and disconnect Bluetooth connection with the host device by pressing 

UP and DOWN buttons if BT Toggle option in BT Config menu is enabled. It normally 

takes 3 seconds to connect and 1 second to disconnect. This is a very useful feature for 

iPhone and iPad application.  

 

User can also enable and disable iPhone and iPad soft key instantly using this BT Toggle 

option.  

UP button shows Bluetooth connection status and DOWN button shows time if KDC is 

connected using SPP profile. 

 

Note: 

  User should unpair the KDC first from the Bluetooth host to change the 
Connect Device setting on the scanner to other Bluetooth profile. 
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4.1.2 Auto Connect  

This feature allows the KDC to connect automatically to the host device when the KDC is 
powered on.  
 

IMPORTANT: Until the host device and KDC have been fully tested, it is strongly 
recommended that this feature be set to Disable because a host device that does not 
support this feature can cause problems such as power loss or upload delays.  

 

[Note] KDC automatically tries to connect to the host 10 times during two minutes when 
Bluetooth power is ON, Bluetooth is disconnected, Auto Connect is enabled and system 
Sleep Timeout is set to 5 seconds 

 

 

4.1.3 Auto Reconnect  

This feature allows the KDC to connect automatically to the host device when the KDC is 
disconnected from a host.  
 

IMPORTANT: This feature is available when KDC “Connect Device” options are 
“iPhone”,”HID iOS” and “HID Normal “. 

 

Note: 

•   KDC tries to connect automatically to the host 10 times during two minutes if 
Bluetooth is disconnected. 

 

 

4.1.4 Auto Power On  

The Auto Power On option allows the KDC to automatically power on Bluetooth when 
the SCAN button is depressed. The default setting is Disabled.   

NOTE: The host may have to open the COM port before reconnecting with the KDC.  
Power-on time determines the scan button pressing time to activate Auto Power On 
feature. 

 

 

4.1.5 PWR ON Time 

The PWR On Time option works in conjunction with the Auto Power On option. Default 
value is Disabled. If KDC Bluetooth power is off, user can turn on Bluetooth power by 
pressing SCAN button for PWR On Time option value. 
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4.1.6 Auto Power Off  

The Auto Power Off option works in conjunction with the PWR Off Time option.   This 
option allows the KDC to power off Bluetooth automatically when the KDC is NOT 
CONNECTED to the host for the time duration specified in the PWR Off Time option.  

The default for this option is Disabled.  It is strongly recommended to keep it enabled to 
maximize the operation time of the KDC.  If Auto Power Off is enabled, Bluetooth can be 
manually powered off before specified time in PWR Off Time option.  

 

4.1.7 Beep Warning  

The KDC beeps to acknowledge the status of the Bluetooth connection as follows:  
 
1.  One high short beep when Bluetooth is connected.  

2.  One low short when Bluetooth is disconnected.  

3.  Five short beeps if:  

� “Beep Warning is ENABLED” 

� “Auto Power Off is DISABLED” 

� “KDC30 is DISCONNECTED from HOST” 

�  “Bluetooth power is ON” 

 

4.1.8 PWR OFF Time  

The PWR Off Time option works in conjunction with the Auto Power Off option.  If Auto 
Power Off is Enabled, the KDC powers off Bluetooth when the time duration specified in 
the PWR Off Time option is met and the KDC is NOT CONNECTED to the host.  The 
time setting for this option is from one (1) minute to 30 minutes. The default is five (5) 
minutes.  

 

4.1.9 PowerOFF Msg 

KDC sends Bluetooth power off message “BTOFF” to the host if PowerOFF message 
option is enabled. 
 

 

4.1.10   MAC Address  

User can verify KDC Bluetooth MAC Address. 

 

4.1.11   FW Version  

User can verify KDC Bluetooth firmware version in BT FW menu. 
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4.1.12   Wakeup Nulls 

The KDC sends three leading Null bytes to wake up Bluetooth connected device. This 
feature can be disabled if Bluetooth connected device doesn’t require additional bytes 
to wake up. 
 

4.1.13   Autolock Time 

iPhone/iPad/iPod touch loses incoming Bluetooth data in sleep mode. Users can set KDC 

Autolock time to the same Autolock time of your iPhone/iPad/iPod touch to use automatic 

wakeup feature in HID mode to prevent data loss. There would be a one second delay of 

barcode transmission if Autolock time is set to more than one minute and the barcode scan 

interval is larger than the auto-lock time. The auto-lock time would be set as 0, 1, 2, 3, 4, 5, 

10, 15 minutes. 0 means iPhone/iPad/iPod touch never enters sleep mode. 

 

4.1.14   HID Keyboard 

User can select international keyboard – English, German, French, Spanish and Italian.  
 

4.1.15   HID Initial and Inter-Character Delay 

Certain applications can't process HID input fast enough and lose some characters during 

transmission. Users would increase initial and inter-character delay to prevent data loss 

during HID transmission 

� HID Initial Delay: Define the initial delay between 1sec to 10sec before data 

transmission in HID mode 

� HID Inter-character Delay: Define the inter-character delay between 10msec 

to 100msec in HID mode 
 

 

4.1.16 Control character transmission in HID mode 

Control characters between ASCII value 0x00 and 0x1F can be replaced by ALT+Numpad 

or ^+Character. 

 

� Disabled � Transmit the original control character 

� Alt+Numpad � Transmit Alt+ ASCII value from Numpad. 

� ^+Character � Control characters would be substituted as following table. 

� Replacement to | � Control characters would be substituted as “|”. 
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Control 

Char 

Transmit 

Chars 

Control 

Char 

Transmit 

Chars 

Control 

Char 

Transmit 

Chars 

Control 

Char 

Transmit 

Chars 

0x01 ^A 0x0B ^K 0x14 ^T 0x1D ^] 
0x02 ^B 0x0C ^L 0x15 ^U 0x1E ^^ 
0x03 ^C 0x0E ^N 0x16 ^V 0x1F ^_ 
0x04 ^D 0x0F ^O 0x17 ^W   
0x05 ^E 0x10 ^P 0x18 ^X   
0x06 ^F 0x11 ^Q 0x19 ^Y   
0x07 ^G 0x12 ^R 0x1A ^Z   
0x09 ^I 0x13 ^S 0x1C ^\   

 
 

4.1.17 Function key transmission in HID mode 

Users can send F1 to F12 function keys by scanning special barcodes in HID mode. 

 

 

4.1.18 Disconnect/Reconnect/BT(HID) Toggle 

Users can disconnect or reconnect the Bluetooth connection or toggle soft keyboard 

using side buttons. 

 

Bluetooth 
Profile 

UP Key 
DOWN Key 

(DisconnectBTN disabled) 
DOWN Key 

(DisconnectBTN enabled) 
SPP Do nothing Do nothing Release BT connection 

HID iOS Reconnect 
Soft Keyboard Toggle  

if pressing less than 3sec, 

Soft Keyboard Toggle if 
pressing less than 3sec, 
Release BT connection 

iPhone Reconnect Do nothing Release BT connection 
SPP 2.0 Do nothing Do nothing Release BT connection 

HID normal Reconnect Do nothing Release BT connection 
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 Bluetooth Service 4.2 

 

4.2.1 Power  

The POWER option allows you to Enable or Disable the Bluetooth functionality of the KDC.   
To use Bluetooth, this option must be set to Enable. However, like all devices enabled for 
Bluetooth, the KDC will search constantly to connect with a Bluetooth host when set to 
Enable. Constant searching for Bluetooth devices increases power consumption. Unless 
you are using Bluetooth with your KDC, this option should be set to Disable.  

 

IMPORTANT: To prevent unnecessary power problems, it is strongly recommended that 
the POWER option be set to Disable if the KDC is idle for an extended period of time.  

 

4.2.2 Pairing  

Before you are able to use Bluetooth, the KDC must be paired with the host device. This 

pairing process only needs to be completed once with each host device. After pairing, the 

host device will always recognize the KDC as a Bluetooth device unless the Bluetooth 

configuration is modified. If it is modified, you may need to pair the devices again.  

 

IMPORTANT: The host device must be configured for Bluetooth before it can be paired 
to the KDC.  

 

Note: 

•  KDC with Bluetooth Spec2.1+EDR doesn’t prompt Pin code entry menu.  

  

 

4.2.3 Discovering  

KDC30 starts to search neighboring Bluetooth devices if this Discovering menu is 

executed. It would take about 30 seconds to finish search and list available neighboring 

Bluetooth devices. User may enter corresponding Bluetooth MAC address in KTSync 

Bluetooth menu instead of searching neighborhood Bluetooth devices. 

 

4.2.4 Connect To 

This option lets you easily connect KDC to Bluetooth devices either previously registered 
in KTSync under the File Menu or discovered/connected from KDC Bluetooth Service 
menu. 
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Note: 

•  There could be an interoperability issue depending on corresponding device 
Bluetooth stack. Master Bluetooth device may request to follow master 
Bluetooth device security procedure if KDC tries to connect to the master 
Bluetooth device. 

 

 

4.2.5 HID Sync 

User can synchronize stored barcode data over HID using HID Sync option. KDC starts to 

transmit all stored barcode data upon executing HID Sync option. This option is available 

when KDC MFi Mode option is disabled.  
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5.  Synchronization 
 

When barcode data is collected, it must be uploaded to your application.  KTSync®, 
which is bundled with the KDC, is a software that allows barcode data to be uploaded to 
any PC, PDA, or smartphone running Android 2.1+, Apple iOS3.1.3+, Blackberry, Mac 
and Windows XP/Vista/7/Mobile 5.0+.  It has three major functions. Windows XP/Vista/7 
version supports all of the following features. Tablet, PDA and Smartphone versions 
support only limited features of PC KTSync. 

� Synchronization - Provides data upload functionality to your applications. 

� Keyboard Emulator - Allows scanned data to be uploaded directly into your 
application as if the data were being entered manually with a keyboard. 

� Application Generation - Allows users to create custom applications or download 
predefined applications such as Master-Slave, Pick/Bin, DB Lookup and Inventory. 

(Application Generation function is not available for KDC30. Only Keyboard 
wedging feature is available for KDC30.)   

Additional functions include: 

� Prefix and Suffix add-ons to eliminate manual data entry. 

� Symbology and Scan Option selections. 

� Barcode Wedging options. 

 

 KTSync Menu  5.1 

KTSync® was installed on your PC during the initial installation process.  Before data can 
be uploaded to any host device, KTSync® must be launched on the host and configured 
to recognize the KDC.  The following screen displays when KTSync® is launched.  

 

 
KDC30 

 
Figure 13 - KTSync® Synchronizer Menu 
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File Menu 

� Connect:  This option displays the Serial port (COM#) assigned to KDC.  You can 
also use this option to manually assign the Serial port. The Serial port assigned 
to KDC can be found under Windows Device Manager. The port assignment is 
used by KTSync® for synchronizing data from the KDC to the host. 

� Synchronize:  This option manually tells the KDC to synchronize data with the 
host. While data is being synchronized, KTSync menu options are unavailable. 

Note: 

•  Please do not use your computer during data synchronization.  

 

� Bluetooth: User can register MAC address to be directly connected by KDC30. 

� Configuration: This option allows users to set different KDCs with same settings 
by exporting and importing settings from one KDC to the other.  

� Exit: This option ends the KTSync program. You must re-run KTSync before you 
can synchronize data on the KDC.   

 

 

 

 

 

 

 

Settings Menu 

� Synchronization: Select Synchronize options. 
� Barcode & KDC: Select Barcode and KDC options. 
� Others: Select Auto Connection and/or Synchronization Confirmation options. 

 

Figure 14 – File Menu 
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Application Menu  

� Generation: Create user application or download predefined application. 

� DB Lookup: Allows users to download DB into KDC and display barcode 

description field 

� Master/Slave: User defines a master barcode for comparison with one or more 

slave barcodes 

� Pick/BIN: User defines Pick ID and the barcode symbology for comparison with a 

defined Bin 

� Inventory: Users can count inventories. Inventory description would be displayed 

if inventory DB is downloaded into KDC. 

 
 
 
 
 
 
 

 

 

About Menu - KTSync® - Version Information 

 

 

 

 

 

 

 

 

Figure 17 – About Menu 

Figure 16 – Application Menu 

Figure 15 – Setting Menu 
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 File Menu  5.2 

 

5.2.1 Connect to KDC 

The KDC connects to a COM port automatically when connected to your PC’s USB port. 
You can manually assign the KDC COM port using KTSync® Connection submenu under 

File menu if needed.   

 

 

 

 

 

 

 

� The COM port assignment is found in the Windows Device Manager. 

� KTSync® will not connect to the KDC if it is in KDC Menus. You must EXIT 
from the KDC Menus. 

� If KTSync® fails to connect automatically to the KDC, please follow these 
directions. 

1. Exit KTSync®. 
2. Check that you have connected the KDC to a USB port on your PC. 
3. Make sure to use the cable provided with the KDC.   
4. Check that the KDC is not in KDC Mode Menu.   
5. Restart KTSync®. 

Note: 

•  You can manually assign the COM port using KTSync® Connect option 
under the File menu 

 

5.2.2 Synchronize 

Under the File Menu, this option allows you to manually synchronize data on KDC with 

the host. This option is similar to clicking on the Synchronize button in the KoamTac Data 

Synchronizer box. 

Figure 18 - COM Port Selection for KDC 
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5.2.3 Bluetooth 

This menu option allows you to register up to ten Bluetooth devices including their MAC 

address, PIN #, and optional prefixes or suffixes. This option enables direct Bluetooth 

connection between KDC and other Bluetooth devices such as Bluetooth printer.  User 

should choose Bluetooth device to be connected in “Connect to” menu in KDC 

Bluetooth Service menu. 

 

      

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 19 - Bluetooth Device Registry 
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5.2.4 Configuration  

This menu is useful for the users who need to configure different KDCs with same 

settings. In this menu, you can export settings from a KDC to your computer and import 

it to other KDCs.  

When you select Configuration in File menu, you will need to choose either Export or 

Import. First, select Export. You name the settings file, press Open, and it is exported to 

your computer. Second, connect a different KDC to your computer and import the 

settings file to the KDC by selecting Import in the Configuration menu. Once 

configuration has been finished, KDC will restart.   

 

 

 

 

� Export 

 

 

 

 

 

� Import 

  

 

 

 

 

Figure 20 – Configuration  
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  Synchronization Settings 5.3 

 

KTSync® provides several synchronization options for synchronizing data from your KDC 
to host devices such as your PC, PDA, or smartphone running Windows XP, Vista, 

Windows 7, or Mobile 5.0+.   

 

  

 

 

5.3.1 Destination of Data 

When barcode data is uploaded to the host device, you must assign a destination for the 
data.  Destination of Data options include: 

� File - This option means data will be saved in the assigned filename. You can select a 
different target directory by clicking the New icon. C:\MyData\sn_timestamp.txt  is 

Figure 21 - KTSync® Synchronization Settings 
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the default directory. If this directory is not created, you will be prompted to create it 
before data can be uploaded to a file. 

� Active Window - This option means scanned barcode data is sent directly to the 
active program running on your device as if the data was being entered directly from 
a keyboard. 

� Microsoft Excel - This option means barcode data is being imported directly into 
Microsoft’s Excel. Various parameters can be set when uploading data to Excel. 

� Select from Current Running Application – This option allows you to select a 
currently running application for data synchronization. 

Note: 

•  Data synchronization begins immediately if Automatically After Connection 
is selected.  If not selected, data synchronization is started manually by the 
user. 

• Users SHOULD NOT operate the PC during the synchronization process. It 
can interrupt the process causing unreliable results. 

 

5.3.2 Synchronization Methods 

Fast Synchronization in Burst Mode 

The KDC can synchronize data to a host device in Burst mode or Sequential mode. Burst 
mode provides the fastest synchronization process but could result in error in a poor 
Bluetooth environment. Fast synchronization in burst mode is only recommended with 
USB connection. 

Synchronize Normal Data 

The KDC will synchronize Normal Data only in KDC memory if Synchronize Normal Data 
option is selected. If you want all data in KDC memory synchronized, you should select 

Synchronize Normal Data and Synchronize Application Data. 

Synchronize Application Data 

The KDC will synchronize Application Data only in KDC memory if Synchronize 
Application Data option is selected. If you want all data in KDC memory synchronized, 

you should select Synchronize Normal Data and Synchronize Application Data. 

Clear KDC Memory after Synchronization 

The stored barcode data is cleared from the KDC memory after synchronization if this 
option is selected. The KDC30 can store a total of 10,240 barcodes or 60KB (86 
version)/160KB (85 version) of barcode data.  
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� It is important to clear the KDC memory periodically to prevent Buffer Full 
message which will prevent the KDC from storing additional data. Stored barcode 
data can also be deleted using the Reset Memory feature on the KDC.  

Automatically Synchronize after Connection 

This option lets you automatically synchronize collected data to your computer 
immediately when the KDC is connected to the host.   

� IMPORTANT:  Remember to configure all options properly before selecting this 
option.   

� Data synchronization can be done manually by clicking the synchronize icon if this 
option is not selected. 

Beep while Synchronization 

You can enable or disable the beep tone during the synchronization process. A beep is 
sounded each and every time barcode data is synchronized if this option is selected.  
The KDC beeps 5 times when the synchronization process is complete. 

Append data to File 

KTSync would append data to the exiting file instead of creating a new file if user has 
specified file name and Append data to File option is enabled. 

 

5.3.3 Current KDC Wedge Method 

The KDC can be configured in one of five Wedge/Store modes 

� Wedge Only - Scanned data is transmitted to the host. The KDC does not store 
scanned data. 

� Wedge & Store - Scanned data is stored in the KDC and transmitted to the host. 
� Store Only - Scanned data is stored in the KDC but NOT transmitted to the host. 
� Save if Sent - Scanned data is stored in the KDC ONLY if transmission to the host 

is successful. 
� Save if Not Sent - Scanned data is stored in the KDC ONLY if transmission to the 

host is unsuccessful. 

Enable Wedge (Handheld Scanner Mode) - This option will be checked if Wedge 
Only or Wedge & Store option is selected. 

Keep Scan Data in KDC - This option will be checked if Store Only or Wedge & 

Store option is selected. 
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5.3.4  Synchronization Options 

Synchronize KDC Time with PC Time when Connected 

This option enables you to synchronize the KDC date and time with the host date and 
time. Synchronization of date and time occurs after the data is uploaded to the host 

device. 

  Delays 
You can set transmission delays between barcodes and characters during the 

synchronization process. It is important to set proper delays to prevent errors during the 

transmission of collected barcodes. Some Windows applications such as Excel require 

longer delay times. 

Attachments 
Timestamp, Barcode Type, and Serial Number can be attached to the scanned barcode 

by selecting these options.  The Serial Number of the KDC can be attached to the Start 

or End of Record. 

Prefix and Suffix 

� Enter the characters you want appended to the front (Prefix) or back (Suffix) of the 
barcode in the Prefix and Suffix fields.  

� The character set is any combination of ASCII characters including alphanumeric, 
line feed (“\n”), and carriage return (“\r”). 

Order and Delimiter 

� Select Order of Data – Type, Data, and Timestamp 
� Select the Delimiter between Data – Tab, Space, Comma, and Semicolon 
� Select the Delimiter between Records – None, LF, CR, Tab, and <LF & CR> 

 

5.3.5 Application Options 

Synchronize Non-Compliant Data 
The KDC will synchronize both compliant and non-compliant data (filtered data) if 
Synchronize Non-Compliant Data option is Enabled. 

Consolidate Steps in One Record 

KTSync will consolidate the data collected in Step 1 with the data collected in Step 2 
and/or Step 3.  Data will be consolidated into one record instead of individual data 
records for each step when Consolidate Steps in One Record is Enabled. Non-complete 
records, i.e. three steps were defined but data was only collected for two steps; would be 

discarded if this option is Enabled. 

Attach Quantity 
Quantity would be attached to the left or right of the data if this option is Enabled. 
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 Barcode & KDC Settings 5.4 

KTSync® allows you to configure the KDC Scan Options and Barcode Settings. The 
configuration options for the KDC using KTSync® are similar to the Set Barcodes, Code 
Options, Data Editing and Scan Options on the KDC Menu. Please refer to 11. Appendix 

A – Barcode & Scan Options for proper barcode settings for your application. 

Note: 

•  You must configure barcode and scan options properly for optimal KDC 
performance 

 

 

 
Figure 22 - Barcode & KDC Settings, Symbologies, Data Editing and Scan Options 
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5.4.1 Select Symbologies and Symbology Options 

The process for scanning and reading barcodes is delicate and complicated.  Although 

your KDC is equipped with a high performance scan engine, if configured incorrectly it 

may not perform at its peak performance level.  To ensure its high performance, the KDC 

comes configured to optimize its scan engine technology.  Unless you clearly understand 

the impact of your changes to the KDC settings, please do not change factory default 

settings. Please refer to Appendix A for details. Pressing the Default icon will reset all 

symbology related options to factory default settings. 

 

5.4.2 Data Editing Option 

Prefix - Allows you to add a prefix to scanned data which can then be stored in KDC or 

wedged to the host. The Prefix format must be defined in the data format menu of 

KTSync. The maximum length for a Prefix is 11 characters. 

Note: 

•  This Prefix option is different from the Prefix option in KTSync which 
appends the prefix to data during synchronization. 

 

Suffix - Allows you to add a suffix to scanned data which can then be stored in KDC or 

wedged to the host. The Suffix must be defined in the data format menu of KTSync. The 

maximum length for a Suffix is 11 characters.  

Note: 

•  This Suffix option is different from the Suffix option in KTSync which 
appends the suffix to data during synchronization. 

 

AIM ID - Allows you to add AIM ID to scanned data which can then be stored in KDC or 

wedged to the host. AIM ID must be defined in data format menu of KTSync. AIM ID is 

either added to the end of Prefix or Suffix. 

Partial Data: Allows you to display and store partial data. User defines the start position 

and number of characters to be displayed and stored. 

� Select the x characters from y position 

� Set Partial Data Start Position to y, Partial Data Length to x, Partial Data 

Action to Select 

� Partial Data Length 0 means Select all characters from y position. 
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� Erase the x characters from y position 

� Set Partial Data Start Position to y, Partial Data Length to x, Partial Data 

Action to Erase 

� Partial Data Length 0 means Erase all characters from y position. 

 

  Other Settings 5.5 

Other options under the Settings menu allow you to select four additional settings. 

 

• Ask Confirmation before Trying Auto Connection prevents unintentional launch 
of KTSync. 

• Ask Confirmation before Starting Auto Synchronization prevents unintentional 
synchronization of data. 

• Minimize KTSync on Start will minimize KTSync and send to the tray upon 
execution. 

• Keep Checking Bluetooth Connection allows reconnection of KDC once 
Bluetooth signal is detected. This feature is useful when moving from Bluetooth 
host device frequently. KTSync will automatically reconnect Bluetooth 
connection when you enter an effective Bluetooth network range.  

 

To select any of these settings, click on the box to the left of the setting. A check mark (√) 
will display next to the setting to indicate that it is selected. 

 

 

 Figure 23 - KTSync® Confirmation Settings 
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 KDC Menu in KTSync  5.6 

After connecting KDC 20 to PC with a USB cable, run KTSync in your PC and you will see 
KDC Menu on the right side of KTSync window. Click KDC Menu, and you can configure 
your KDC30 in KDC Menu window as below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                          Figure 24 – KDC Menu in KTSync (KDC30) 
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 Mobile pKTSync 5.7 

pKTSync provides limited functionality for Pocket PC 2003 and Mobile 5.0+ users. 

1. Synchronization - Provides data upload functionality to your applications. 

2. Keyboard Emulator - Allows scanned data to be uploaded directly into your 
application as if the data were being entered manually on a keyboard. 

 

For detailed explanations of these functions, please refer to earlier sections of this 
chapter.  

WARNING: The user must assign the correct COM port to KDC prior to use pKTSync. 
Please refer to your mobile device manual for details on Bluetooth pairing and COM 
port assignment methods. 

 

                

 

                

 Figure 25 – Mobile pKTSync 
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 Android aKTSync 5.8 

The aKTSync provides limited functionality of PC KTSync to Android users.  

Note: 

•  aKTSync only supports Android devices with 2.1+ OS version and that are 
compatible with BluetoothChat application. 

• KDC with Bluetooth Spec2.1+EDR doesn’t prompt Pin code entry menu 

  

5.8.1 KDC and Android Pairing 

1. Pairing 

� Select SPP Bluetooth profile from KDC ConnectDevice submenu in BT 

Config menu. 

� Search KDCxxx from Android and pairing two devices. 

� KDCxxx PIN code is “0000” if SPP2.0 is selected. 

2. Connection 

� Click Connect icon in aKTSync 

� Android would list up paired Bluetooth devices and user should select the 
target KDC. 

3. Synchronization: Provides data upload functionality to your applications. 

4. Settings: User can change various Synchronization options in settings menu. 

5. Wedging: User can wedge barcode data to any Android application. Press home 
key and launch the target application.  

 

5.8.2 Launch KTSync 

1. Download and install aKTSync from the Android Play Store. 

http://www.androidzoom.com/android_applications/productivity/ktsync_luxv.html 

2. Change KDC Bluetooth ConnectDevice option to SPP 

3. Execute Android Bluetooth device scan option and KDC Bluetooth pairing option 

A. Execute KDC Bluetooth Pairing option  

B. Launch Settings on the Android device 

C. Select Wireless and Networks 

D. Click on Bluetooth Settings 

E. Click on Scan devices 
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F. The Android device will display the KDC model and 6 digits of the serial number.  

4. Press the KDC list entry, enter “0000” PIN code and press OK. 

5. When paired, the Android device will display “Paired but not connected”. 

6. Launch aKTSync program.  

A. Press menu key and select the Connect option on the top left. 

B. From the list of paired devices, choose the KDC to use. 

C. On the top menu bar of aKTSync, you will see a message “connecting”, and then 

“connected”. 

D. On the KDC display, you will see “Pairing Succeeded!!!” then “Bluetooth 

Connected”. 

E. Select Settings option on the bottom left to change aKTSync setting. 

            

 

 

5.8.3 Keyboard Wedge 

1. Launch Settings on the Android device. 

2. Select Language and Keyboard (or Input method). 

3. Select KTSync Keyboard. 

4. Launch the application and touch the input box to give focus to it. 

5. Barcode would be wedged to the input box upon scanning a barcode. 

 

Figure 26 – Android aKTSync 
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 iPad/iPhone/iPod touch KTSync 5.9 

The KTSync for iPad/iPhone/iPod touch provides limited functionality of PC KTSync for 
iPad, iPhone and iPod touch users.  

1. The KDC supports SPP and iPhone Bluetooth profiles. 

2. The iPhone/iPad/iPod touch should use iPhone Bluetooth profiles. iPhone is 

the default profile of KDCi models. 

3. Download the KTSync program from the App Store. 

4. Enable the iPhone/iPad/iPod touch Bluetooth power from the Setting > 

General > Bluetooth menu. 

Note: 

•  Users have to disable MFi option in System > MFi menu to use HID 
Bluetooth profiles. 

• Users have to RESET the iPhone/iPad/iPod touch to change “HID to iPhone 
mode” or “vice versa” after removing previous KDC connection. 

• KDC with Bluetooth Spec2.1+EDR doesn’t prompt Pin code entry menu. 

 

5.9.1 KDC30i connection using iPhone mode 

1. Download and install iKTSync from the Apple App Store. 

http://itunes.apple.com/us/app/ktsync/id372916602?mt=8 

2. Press the two KDC side buttons together to enter menu mode 

3. Scroll down to Bluetooth menu using KDC Down button 

4. Press the front middle scan button 

5. Scroll down to Discovering and press the front middle scan button 

a. “Discovering Started …” message will be displayed on KDC screen 

b. Discovering will take about 30 seconds. 

6. Select discovered iPhone/iPod touch device name and press the front 

middle scan button 

a. [Pin Code] User Default/Enter PinCode will be displayed 

b. Press the front middle scan button to select the Use Default option 

c. The message “Connecting to iPhone/iPod touch device name” will be 

displayed 

d. iPhone/iPad/iPod touch will ask for the PIN number. 

f. Please enter “0000” and hit “connect” icon 

g.“iPhone Connected” message will be displayed 

7. Launch KTSync and configure Settings 
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5.9.2 iKTSync Settings 

iKTSync provides following Settings menu. 

• Synchronization - User can configure Synchronization options such as 

destination of data, data formation and delimiters. 

        

    

 

 

 

 

 

5.9.3 How to connect and reconnect iPhone mode using UP keys 

1. Users needs to select the option to use this feature in the BT Config > BT Toggle 

2. Press the UP button to connect or reconnect to the iPhone/iPad/iPod touch 

 

 

 

 

 

 

Figure 27 – iPad/iPhone/iPod touch KTSync 
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 Blackberry bKTSync 5.10 

 

The bKTSync provides limited functionality of PC KTSync for Blackberry users.  

Note: 

•  KDC with Bluetooth Spec2.1+EDR doesn’t prompt Pin code entry menu. 

  

 

1. Download and install bKTSync from the Blackberry App World. 

http://appworld.blackberry.com/webstore/search/ktsync?lang=en 

2. Go to Blackberry Options > Applications menu and enable Input Simulation option. 

3. Change KDC Bluetooth profile in ConnectDevice option to SPP. 

4. Execute Blackberry Bluetooth manager and KDC Bluetooth pairing option 

A. Execute KDC Bluetooth Pairing option  

B. Launch the Blackberry Bluetooth manager and select “Search”. The KDC model and 

6 digits of the serial number would be displayed. 

C. Highlight the KDC and press the Enter or Select Key 

D. Enter  “0000” PIN code and press the Enter or Select Key 

E. The Blackberry will display “Pairing with KDC”…”complete.” 

F. Close the Blackberry Bluetooth manager 

5. Go to Downloads folder and execute KTSync 

6. User can configure KDC options in KDC settings and Symbologies Settings menu 

7. Go to KTSync Synchronization Settings and select Destination. To send collected barcode 

data as an email attachment, choose Email Attachment as destination and enter in the 

email address, subject and body message that you want to send. You can enter multiple 

email addresses using the semicolon (;) separator. 

8. To scan barcodes into any application (like email, notes, worksheet or web browser), press the 

menu key and select Running in the background option. bKTSync will maintain the 

connection and place the scanned barcode data wherever the cursor is flashing. 
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Figure 28 – Blackberry bKTSync 
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 KTSync for Mac OS X 5.11 

 

The KTSync Mac OS X version provides limited functionality of PC Windows KTSync for 
Mac OS X users. 
 
 

Note: 

•  KTSync for Mac OS X version supports both Bluetooth SPP profile and USB 
connection. User should pair KDC with Mac before using the KTSync 
program via Bluetooth connection.  

• Mac OS X version KTSync is built as a X86 binary application and works with 
the Intel-based Mac. It is verified on Mac PC running Mac OS X 10.6.5 and 
later versions. 

 
KTSync Mac OS X version supports the following features: 
 

� Keyboard wedge function to a file, internal viewer, active window and user 
application. 

� Synchronization to a file, internal viewer, active window and user application. 
� Automatic connection and disconnection on USB port. 

 

User will see the following initial KTSync screen upon launching the program. KTSync will 

connect automatically if KDC is plugged on USB port or KDC is paired. 
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5.11.1   Connect Button 

User can connect the Mac with the KDC that is paired or plugged into 

the USB port by clicking the Connect button. The following screen will be 

displayed when this button is pressed and KTSync will start to connect to 

the selected KDC. 

 

 

 
 
 

5.11.2   Disconnect Button 

KTSync changes Connect button to Disconnect button once the 

KDC is connected. User can disconnect the KDC manually by 

selecting connected KDC on the following screen. 

 

 

 

5.11.3   Synchronize Button 

User can start the synchronization process by pressing the 

Synchronize button. User can select the destination of barcode data 

in the settings menu. There are 4 selectable destinations: File, 

Internal viewer, Active window and User application. 

 

5.11.4   Clear Button  

 

 

User may press this button to clear the KTSync internal viewer. 
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5.11.5   Settings Button 

 

User can configure synchronization options on the following screen by 

pressing the Settings button. 

 

 

Destination of data 
 
The KTSync program wedges or downloads barcode data to one of the following 
four destinations: 
 
 
 

 
 
 

o File: The KTSync makes file name based on 3.11 if file name is specified as a 
“sn_timestamp.txt”. The default directory is  /Users/Shared/KTSyncData 
directory. User can define other directory or other filename by clicking “New” 
button. The maximum file path length is 128 characters. 

o Internal viewer: The KTSync displays barcode data in KTSync internal text 
viewer. 

o Active window: The KTSync sends barcode data to current active window if 
Active window option is selected. 

o User application: User can define the target application by pressing “New” 
button. The maximum application name path length is 128 characters. 
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Synchronization Options  
 

� Synchronize KDC clock 
KTSync will set the KDC’s date and time with Mac PC date and time when 
the KDC is connected to Mac if this option is enabled. 

 
� Burst synchronization 

KTSync will synchronize barcode data from KDC in the burst mode if this 
option is enabled. Otherwise, KTSync will synchronize barcode data one by 
one. This option is enabled by default and can’t be disabled. 

 
� Synchronization on connection 

If this option is enabled, KTSync will automatically synchronize barcode data 
from the KDC when the KDC is connected. 

 
� Clear KDC memory after synchronization 

KTSync clears barcode data stored in the KDC’s memory once 
synchronization has 
finished if this option is enabled. 

 
� Append data to file 

KTSync appends synchronized data to existing file specified on destination. If 
file doesn’t exist then KTSync creates a new file. 

 
 
Data Edition  

� Attach serial number 
The KTSync would add a KDC serial number to barcode data if this option is 
enabled. This option is enabled by default and can’t be disabled. 

 
� Attach time stamp 

The KTSync would add timestamp to barcode data if this option is enabled. 
This option is enabled by default and can’t be disabled. 

 
� Attached barcode type 

The KTSync would add barcode type to barcode data if this option is 
enabled. This option is enabled by default and can’t be disabled. 

 
� Serial number 

When Attach serial number is enabled, this option determines when to 
attach serial number. “Start of record” means to attach at the front of record 
and “End of record” means to attach to the end of record. 

 
� Data order 

This option specifies the order of data (Barcode Type, Barcode Data and 
Timestamp) in the record. 
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� Data delimiter 

This option is used to select a character to be added between barcode data, 
serial number and timestamp and/or barcode type. User can select one of 
the following: None, Tab, Space, Comma and Semicolon as the data 
delimiter. The Comma is selected by default and can’t be changed. 

 
� Record delimiter 

This option is used to select a character to be added at the end of the 
barcode record. User can select one of None, CR, LF, TAB, and CR&LF as the 
record delimiter. The CR&LF is selected by default and can’t be changed. 

 

Other Options 

� Non-English keyboard 
This option is used when the barcode data has non-English characters and a 
non-English keyboard.  
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6. TROUBLESHOOTING 

 

PROBLEM CAUSE SOLUTION 

KDC not working 
Dead battery 

� Charge battery by connecting KDC to your PC using the 
included cable 

Hardware failure �   Contact distributor for technical support 

KDC not charging 
Bad battery � Replace battery – Contact Local Distributor 

Poor USB port 
�   USB port doesn’t supply proper current to KDC  

- Charge KDC using a different USB port on your PC 

Failed reading 

Damaged barcode � Scan a different barcode 

Out of scan range 
� Move the scanner closer to barcode 
�   Move scanner farther from the barcode 

Incorrect angle �   Change the angle of scanner to barcode 
Symbology 

 not supported 
�   Contact KoamTac - www.koamtac.com for possibility of 

custom symbology support 

Scan options �   Check scan option settings 

Dirty scan window �   Clean scan window 

Damaged scan window �   Replace scan window 

KDC reads 
wrong barcode 

Dirty scan window � Clean scan window 

Damaged scan window �   Replace scan window 

Poor quality barcode 
� Select only necessary barcodes 
� Increase minimum barcode length 
�   Increase security level 

Can’t communicate 
with PC, PDA, 
or smartphone 

USB cable is not  
connected properly

� Check cable connection between  KDC and host device 

Software is not 
working properly 

�   Reload the software 

COM configuration �   Check COM port configurations 

LED blinks yellow Low battery power 
� Charge the battery by connecting KDC to PC. 
� KDC will lose collected data if the battery is empty. 

Buffer Full Message Full Memory � Clear the Memory using Synchronization program 

Empty Battery 
 Message 

Empty battery 
� Connect USB immediately. 
� Synchronize the collected data and charge KDC 

Abnormal KTSync  
Operation on DELL PC

Quickset Utility 
� Disable Quickset Utility before using KTSync. 
� Dell Quickset utility interrupts  normal KTSync 

operation 

WSED Utility 

� Disable WSED Wireless enable/disable utility 
� delete the folder C:\Program Files\WSED, 

which contains a file WSED.exe, with the same icon as 
in the taskbar 
� Delete the registry entry KEY_LOCAL_MACHINE 

\SOFTWARE\Microsoft\Windows\CurrentVersion\Run\
WSED 

Table 4 - Troubleshooting Techniques 
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7. WARRANTY 
 

LIMITED WARRANTY AND DISCLAIMERS 

BY OPENING THE PACKAGE OF THIS PRODUCT YOU AGREE TO BECOME BOUND BY THE 
LIABILITY AND WARRANTY CONDITIONS AS DESCRIBED BELOW. 

UNDER ALL CIRCUMSTANCES THIS MANUAL SHOULD BE READ ATTENTIVELY, BEFORE 
INSTALLING AND OR USING THE PRODUCT. 

 

Serial Number 

A serial number appears on the KDC label. This official registration number is strictly related to 
the device purchased. Make sure that the serial number appearing on your KDC is not 
removed. Removing the serial number will affect the warranty conditions and liability 
disadvantageously, so please maintain the label with serial number on the KDC.  Units with the 
serial number label removed should not be operated. 

 

Warranty/Warranty Period/Liability 

KoamTac, Inc. (“KoamTac”) manufactures its hardware products in accordance with industry-
standard practices. Unless otherwise agreed in a contract, KDC is warranted for a period of one 
year after purchase, covering defects in material and workmanship except rechargeable battery. 
KoamTac will repair or, at its opinion, replace products that prove to be defective in material or 
workmanship under proper use during the warranty period. KoamTac will not be liable in cases 
(i) in which the unit  has been repaired or altered unless done or approved by KoamTac, (ii) in 
which the unit  has not been maintained in accordance with any operating or handling 
instructions supplied by KoamTac, (iii) in which the unit has been subjected to unusual physical 
or electrical stress, misuse, abuse, power shortage, negligence or accident or (iv) in which the 
unit has been used other than in accordance with the product operating and handling 
instructions. Preventive maintenance is the responsibility of the customer and is not covered 
under this warranty. Under no circumstance will KoamTac be liable for any direct, indirect, 
consequential or incidental damages arising out of use or inability to use either the hardware or 
software, even if KoamTac has been informed about the possibility of such damages. 

 

Warranty Coverage and Procedure 

During the warranty period, KoamTac will repair or replace defective products returned to 
KoamTac warehouse. International customers should contact the local KoamTac office or 
support center. If warranty service is required, KoamTac will issue a Return Material 
Authorization Number. Products must be shipped in the original or comparable package, 
shipping and insurance charges prepaid. KoamTac will ship the repaired or replacement 
product freight and insurance prepaid. Customer accepts full responsibility for its software and 
data including the appropriate backup thereof. Repair or replacement of a product during 
warranty will not extend the original warranty term. 
 

CAUTION: Changes or modifications not expressly approved by the manufacturer responsible 
for compliance could void the user’s authority to operate the equipment.
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8. Contact Information  

 

 

 

 

 

 

 

 

CORPORATE HEADQUARTERS 

116 Village Blvd., Suite 305 

Princeton, NJ 08540, USA 

Phone: 609-256-4700, FAX: 609-228-4373 

 Email: support@koamtac.com 
 

 

For more information, visit our website - www.koamtac.com 

 

 

 

 

 

  




